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Before You Install

Welcome to LoadRunner, Mercury Interactive’s automated load testing tool 
for Windows and UNIX systems. This guide describes everything you need 
to know to install LoadRunner. It describes the LoadRunner package 
contents, the required system configuration, registration and backup 
procedures, and how to run the setup programs.

Before you begin to install LoadRunner, review the following pre-
installation procedures.

Checking Your LoadRunner Package

Make sure that your LoadRunner package contains the items described 
below. If any items are missing or damaged, contact Mercury Interactive or 
your local distributor.

CD-ROMS

Your LoadRunner package includes a Windows CD-ROM and a UNIX 
CD-ROM containing the LoadRunner program and associated files.

Documentation

LoadRunner is supplied with a set of documentation that describes how to:

install LoadRunner

create virtual user scripts

use the LoadRunner Controller

analyze the results
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Registering Your Copy of LoadRunner

Register your copy of LoadRunner to become a licensed user with all rights 
and privileges. Registered users have access to technical support and 
information on all Mercury Interactive products. You will also be eligible for 
updates and upgrades.

To register your copy of LoadRunner, fill out the Mercury Interactive 
Software Registration card.

If you are in the USA, fill out the USA Owners portion of the card. Send the 
card to the Sunnyvale, California address printed on the card. No postage is 
necessary.

If you are outside the United States, fill out the Non-USA portion of the 
registration card and send it to the appropriate international address. Affix 
postage to the card before mailing.

Remember to notify Mercury Interactive or your local representative if you 
move to a new address, so that you can continue to receive product 
information and updates.

Note: You can also register your copy of LoadRunner on Mercury 
Interactive’s Customer Support site: http://support.mercuryinteractive.com.
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Where To Go From Here?

Your LoadRunner CD-ROM includes all the files that you need to install 
LoadRunner. Your actual setup procedure will differ depending on the 
environment that you will be testing using LoadRunner:

If your environment consists of only Windows-based machines (i.e. the 
Controller and all the Vusers will run on Windows-based machines), follow 
the setup procedure described in Part I of this guide.

If your environment consists of both Windows-based and UNIX-based 
machines, follow the setup procedures described in Part I and Part II of this 
guide.

Terminology

Vuser A virtual user—a LoadRunner-created user 
that emulates a human user.

Load Generator machine The workstation used to host the LoadRunner 
Vusers.

Controller machine The machine used to host the LoadRunner 
Controller.

Vuser Group A collection of Vusers with common 
characteristics, such as the machine on which 
they run, or the client that they use. 

If your testing environment is... See

Windows only Part I

Windows and Unix Part I and Part II
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Typographical Conventions

This book uses the following typographical conventions:

1, 2, 3 Bold numbers indicate steps in a procedure.

Bullets indicate options and features.

> The greater than sign separates menu levels (for 
example, File > Open).

Stone Sans The Stone Sans font indicates names of interface 
elements on which you perform actions (for example, 
“Click the Run button.”).

Bold Bold text indicates method or function names

Italics Italic text indicates method or function arguments, file 
names or paths, and book titles.

Helvetica The Helvetica font is used for examples and text that is 
to be typed literally.

<> Angle brackets enclose a part of a file path or URL 
address that may vary from user to user (for example, 
<Product installation folder>\bin).

[  ] Square brackets enclose optional arguments.

{ } Curly brackets indicate that one of the enclosed values 
must be assigned to the current argument.

... In a line of syntax, an ellipsis indicates that more items 
of the same format may be included. 
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1
Introducing the Windows Installation

Your LoadRunner CD-ROM includes a setup program that guides you 
through the process of installing LoadRunner’s components. 

The setup program installs LoadRunner on the hard disk of a single-user 
computer. For details, see Chapter 2, “Installing LoadRunner on Your 
Computer.”

You can install the LoadRunner Controller, the virtual user components, or 
both.
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Windows System Requirements

In order to successfully run LoadRunner, you need the following minimum 
system configuration.

Requirement
Controller with 
Online Monitors

Virtual Vuser 
Generator

Virtual Users Analysis Module 

Computer/ 
Processor 

Pentium 350 
MHZ or higher 

Pentium 350 
MHZ or higher 

Pentium 1 GHz 
or higher  

Pentium 350 
MHZ or higher 

Operating 
System 

Windows NT® 
service pack 6 
and higher
Windows 2000 
including
service packs 2 
and 3
Windows XP 
Professional 
including
service pack 1

Windows NT® 
service pack 6 
and higher
Windows 2000 
including
service packs 2 
and 3
Windows XP 
Professional 
including
service pack 1

Windows NT® 
service pack 6 
and higher
Windows 2000 
including
service packs 2 
and 3
Windows XP 
Professional 
including
service pack 1

Windows NT® 
service pack 6 
and higher
Windows 2000 
including
service packs 2 
and 3
Windows XP 
Professional 
including
service pack 1

Memory 128 MB or more 128 MB or more At least 1 MB 
RAM for non-
multithreaded 
Vuser or at least 
512 KB multi-
threaded Vuser  

128 MB or more 

Swap Space Two times the 
total physical 
memory 

Two times the 
total physical 
memory 

Two times the 
total physical 
memory 

Two times the 
total physical 
memory 

Hard Disk 
Space 

Installation: 
300 MB

Installation: 
300 MB

Installation: 130 
MB

Installation: 100 
MB

Free: 200 MB Free: 200 MB Free: Minimum 
500 MB 

Free: Minimum 
500 MB 

Browser IE 5.x or higher
Netscape 
Navigator 4.x, 
6.x

IE 5.x or higher
Netscape 
Navigator 4.x, 
6.x

N/A IE 5.x or higher
Netscape 
Navigator 4.x, 
6.x
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Note: Refer to http://www.mercuryinteractive.com/products/loadrunner/technical/ 
for the most updated installation requirements.
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2
Installing LoadRunner on Your Computer

Before Installing LoadRunner 7.8, be sure to uninstall any previous versions 
of LoadRunner.

The setup program installs LoadRunner on the hard disk of a single-user 
computer.

You can install the Controller, virtual user components, or both. In 
addition, you can choose to install the full LoadRunner configuration, a 
load generator configuration, or a custom configuration. Choosing custom 
configuration lets you specify which LoadRunner components to install. 

Performing the Installation

Note: You must log on as an NT Administrator when performing an 
installation on Windows NT 4.0 or higher. 

To install LoadRunner on your computer:

 1 Insert the LoadRunner CD-ROM into a CD-ROM drive.

 2 Click Start, and select Run. 

 3 Type the location that you are installing from, followed by setup.exe. For 
example, if your CD-ROM drive letter is M, type:

m:\win32\setup.exe
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 4 The LoadRunner Setup program begins and displays the main installation 
screen.

Select the desired type of installation: LoadRunner, Load Generator, WAN 
Emulator Driver, Remote Performance Monitor, Monitors Over Firewall, or 
MI Listener.

LoadRunner Full Setup provides the option to install the LoadRunner 
Controller, Virtual User (including GUI) components, online 
documentation, script samples, Load Generator, MI Listener, and support 
for the Remote Performance monitor. Use this option for the machine that 
controls the Vusers. 

Load Generator installs the components needed for running virtual users to 
generate load, and the MI Listener. Use this option for machines that are 
used only to generate load and not to control Vusers.
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WAN Emulator Driver installs a driver that enables you to emulate the 
behavior of a wide variety of network infrastructures during a load testing 
scenario. Install this driver on a Load Generator machine.

Remote Performance Monitor configures an IIS Web server for the Remote 
Performance monitor. This requires a machine with IIS installed. For more 
information about the Remote Performance monitor, refer to the 
LoadRunner Controller User’s Guide.

Monitors Over Firewall installs the components on the agent machine for 
monitoring over the firewall. For more information, refer to the Using 
Firewalls chapter of the LoadRunner Controller User’s Guide.

MI Listener installs the components needed on the MI Listener machine 
used in running Vusers over a firewall and monitoring over a firewall. For 
more information about working with firewalls, refer to the LoadRunner 
Controller User’s Guide.

Click an option to launch the Installshield Wizard and begin installation.

If you selected the WAN Emulation Driver installation, the LoadRunner 
installation creates a new program folder on the Load Generator machine, 
and begins copying files. Note that the WAN Emulation driver installation 
may disconnect your open network connections.

 5 If you selected LoadRunner, Load Generator, Remote Performance Monitor 
Server, or Monitors Over Firewall, the installation displays the software 
license agreement.
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Read the agreement and click Yes to accept it and to display the Registration 
Information dialog box. 

 6 In the Registration Information dialog box, type your name, the name of 
your company, and your LoadRunner maintenance number. You can find 
the maintenance number in the maintenance pack shipped with 
LoadRunner.

Click Next.
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 7 If you are performing a full installation, the Setup Type dialog box displays 
the following options.

Select the type of installation that you want: Typical or Custom.

Typical Installation installs all commonly-used LoadRunner components, 
including the LoadRunner Controller, Virtual User (including GUI) 
components, online documentation, and script samples. Use this option for 
the machine that controls the Vusers.

Custom Installation lets you install all the LoadRunner components, or 
select the components that you want to install. For details, see “Custom 
Installation Options,” on page 19.

Click Next.
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 8 If you are performing a full installation, the License dialog box displays the 
settings for the current LoadRunner license on your machine. 

Enter the LoadRunner license key from your license agreement. If you are 
evaluating LoadRunner or waiting for a permanent license key, enter the 
license key ‘TEMPORARY’. This will let you run up to 25 virtual users for a 
period of 10 days.

Click Next.

If you have a temporary license, LoadRunner issues a reminder indicating 
that you have 10 days to evaluate the product with 25 Vusers. Click OK. The 
LoadRunner installation updates the license information.
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 9 In the Choose Destination Location dialog box, specify the location where 
you want to install LoadRunner. To select a different location, click Browse, 
choose a folder, and click OK.

Click Next.
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 10 In the Select Program Folder dialog box, specify a program folder, or accept 
the default folder, LoadRunner. 

Click Next.
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 11 If you are installing the Remote Performance Monitor Server, the 
installation program displays the default user name and password used by 
the Web server running IIS. You can accept the defaults or enter your own 
values.

Note: After you complete the Remote Performance Monitor Server 
installation, you need to enter the same user name and password in the 
LoadRunner Controller RPM User Configuration dialog box. On the 
Controller machine, select Start > Programs > LoadRunner > Tools > RPM 
User Configuration. Enter the specified user name and password in the 
relevant fields, and click Close.
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 12 The installation settings that you selected are displayed in a read-only 
window. To select different installation settings, click Back. To begin 
installation, click Next. The installation process begins.

 13 In the User Login Settings dialog box, select a user login setting.

Select one of the following user login settings:

Allow virtual users to run on this machine without user login: An NT service 
running on this machine will recognize these user credentials, so the virtual 
users can run without any manual intervention. Enter a user name and 
password for a user that exists on the network domain where the user 
machine resides. Note that the user must have administrator privileges.

Note: You must boot and log in to the system at least once after the 
LoadRunner installation before the automatic login can work.
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Manual log in to the Load Generator machine: The user must manually log 
into the network from the Load Generator machine for each session of 
running Vusers.

Click OK.

 14 In the Registration Information dialog box click Next to complete the 
installation.

 15 The setup program prompts you to restart your computer. You can delay 
restarting your computer until a later point.

Note: The following message appears the first time that a user logs on after a 
full LoadRunner installation: "HCL Inetd CPLInquire cpl 8af40c". This 
message relates to the HCL (Hummingbird Communications Ltd.) Inetd 
service, when Inetd is installed as a Windows NT service. Please close the 
message box and continue to start your computer.

The LoadRunner installation is now complete.
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Completing the LoadRunner Installation Process

To complete the LoadRunner installation process:

Select Start > Programs > LoadRunner > Readme to see what’s new in 
LoadRunner, and any last-minute limitations.

You use the Acrobat Reader to view the LoadRunner online documentation.

To install the Acrobat Reader, browse to the Adobe site at 
http://www.adobe.com/products/acrobat/main.html and install the latest 
version.

Note: Before you run the Acrobat Reader setup, uninstall any previous 
versions of Acrobat Reader. If you already have version 5.05 installed, it is 
not necessary to run the Acrobat Reader setup. 

To complete LoadRunner’s sample installation, run the Samples setup after 
LoadRunner setup is complete. Refer to Chapter 5, “Installing LoadRunner 
Samples” for explanations of the sample tests and setup instructions.

If your version of LoadRunner is supplied with a plug and you have not 
already installed the plug, do so now by inserting it in the parallel port.

To create Vuser scripts for Baan, you need to specify the correct application 
server in the Baan user file:

The user file, u[username], is located under the Baan installation folder in 
bse/lib/user. Add the following line to the beginning of the user file:

std_program:ottstpteststand

This tells LoadRunner to use the Test Standard Program when recording and 
running Vusers.

To start LoadRunner, select Start > Programs > LoadRunner > Controller.
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Custom Installation Options

If you choose to perform a Custom installation of LoadRunner, the setup 
program allows you to select the LoadRunner components that you want to 
install. You can install the following LoadRunner components: 

Controller: Controls the execution of scenarios and Vusers. Includes the 
online monitors which monitor and display information about the test 
execution.

Analysis: Graphs and reports for analyzing the load test.

Vuser Generator: LoadRunner’s tool for creating virtual user (Vuser) scripts, 
through recording. Vuser scripts emulate users without a graphical user 
interface by using direct function calls. See the Readme file for supported 
protocols.

Load Generator: The components for running virtual users (including 
Windows-based GUI Vusers) to generate load. Note that you must have 
WinRunner installed to run GUI Vusers.

MI Listener Component: Components for the MI Listener machine used in 
running Vusers and monitoring over the firewall. For more information, 
refer to the Using Firewalls chapter of the LoadRunner Controller User’s Guide.

Monitors over FireWall: Components on the agent machine for 
monitoring over the firewall. For more information, refer to the Using 
Firewalls chapter of the LoadRunner Controller User’s Guide.

Online Documentation: All user guides in Acrobat format.

Samples: The LoadRunner sample flight application.
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Clear the check boxes next to the components that you do not want to 
install, and select the check boxes next to the components that you want to 
install. 

Click Next to proceed with the installation process.

Running the Uninstall Program

Your LoadRunner installation includes an uninstall program which 
uninstalls LoadRunner software and files from your computer and removes 
LoadRunner shortcuts from your Start menu.

To run the LoadRunner uninstall program:

 1 Click Start > Programs > LoadRunner > Uninstall LoadRunner.

 2 A message asks you to confirm your decision to uninstall LoadRunner.
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Click Yes to uninstall LoadRunner. Otherwise, click No to keep LoadRunner 
installed on your computer.

If you clicked Yes, the Uninstall Shield dialog box opens.

 3 You may be prompted to terminate an active magentproc.exe process.

Click Yes to terminate the process. Otherwise, click No to exit the uninstall 
program without removing LoadRunner from your computer.

 4 You may be prompted to remove shared files that are not being used by any 
program. If you are not sure what to do, click No to All.

The Uninstall program removes LoadRunner from your computer.

 5 When the Uninstall program is completed, you are prompted to restart your 
computer. Click Yes to immediately restart. Otherwise, click No to delay 
restarting your computer. If you click No, close all your applications and 
restart your computer as soon as possible.

Note: To uninstall LoadRunner immediately after you have installed the 
program, first restart your computer.
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3
Adding LoadRunner Components

After you install LoadRunner, you can run the setup program at any time to 
add LoadRunner components, such as samples, the Virtual User Generator, 
or the online documentation. 

To add components:

 1 Insert the LoadRunner CD-ROM into a CD-ROM drive.

 2 Click the Start button, and select Run. 

 3 Type the location that you are installing from, followed by setup.exe. For 
example, if your CD-ROM letter is M, type:

Click OK.

 4 The Installshield Wizard begins and displays the software licensing 
agreement. Read the agreement and click Yes to accept it. The LoadRunner 
setup program starts. 

 5 In the User Information dialog box, type your name, the name of your 
company, and a LoadRunner serial number. You can find this number on 
the outside of your LoadRunner box. Click Next.

 6 Click Custom Installation, and then click Next.

Select the LoadRunner components that you want to add. Clear the check 
boxes next to the options that you do not want to add. 

m:\win32\setup.exe



LoadRunner Installation Guide • Windows Installation

24

Note: The custom installation procedure will not remove previously-
installed components that are not checked.

Click Next.

 7 The installation settings you selected are displayed in a read-only window. 
Review the settings. If you want to select different installation settings, click 
Back. If you are satisfied with the installation settings, click Next. The 
installation process begins.

 8 If you installed LoadRunner’s samples, a message tells you to run the 
samples setup from the LoadRunner Samples program group to complete 
the samples installation. Refer to Chapter 5, “Installing LoadRunner 
Samples” for detailed explanations of the sample tests and setup 
instructions. 

Click OK to continue with the setup procedure.

 9 By default, the setup program creates the program group, LoadRunner, and 
creates the LoadRunner icons in the program group.

To add the LoadRunner icons to an existing program group, select the group 
from the list of Existing Groups. Click Next.
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 10 Depending on which components you added, the setup program either 
prompts you to restart your computer or informs you that the setup is 
complete. You can delay restarting the computer until a later time.

 11 If you installed LoadRunner’s online documentation, you use the Acrobat 
Reader to view the documentation files. 

To install the Acrobat Reader, browse to the Adobe site at 
http://www.adobe.com/products/acrobat/main.html and install the latest 
version.

Note: Before you run the Acrobat Reader setup, uninstall any previous 
versions of Acrobat Reader. If you already have version 5.05 installed, it is 
not necessary to run the Acrobat Reader setup. 
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4
Viewing and Modifying a License

You can modify your license at any time directly from the LoadRunner 
interface. This chapter describes:

Viewing License Information

Modifying a License

Troubleshooting

Normally, you enter your license key during installation. The setup program 
prompts you for a license key. If you do not have your license key at the 
time of installation, you can use the temporary license by typing 
‘TEMPORARY’ in the license key box. This grants you a 10 day license for 25 
users. Afterwards contact Mercury Interactive Customer Support to obtain 
your permanent license key.

This chapter describes how to enter a license key not during installation, and 
how to upgrade an existing license. 

Viewing License Information

You can only view license information from the LoadRunner Controller, not 
from the Virtual User Generator.

To view the current license information:

 1 In the Controller, choose Help > About LoadRunner, and click License Info. 
The License dialog box opens, displaying the license information.

 2 Scroll through the license information to determine the scope of your 
current license. 
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The License Keys list lists all the available license keys. In addition, you can 
select to view a summary of all the information in all the license keys.

The License Key Information box displays the license type, validity 
duration, Vuser types, and monitors for each selected license key. 

The following types of licenses are available:

Permanent: The license never expires.

Time Limited: The license is limited by a start date and an expiration date.

Temporary: The license is granted for a pre-defined number of days after 
product installation.

VUD-based: The license is limited by a number of Virtual User Days (VUDs). 
A VUD license enables the user to use the product an unlimited number of 
times within a period of 24 hours.

Plugged: The license requires a dongle.
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The following groups of Vuser protocols are available:

Global: The license lets you run all Vuser types, provided you stay within 
the global, or total limit. The number following Global indicates the total 
number of Vusers purchased. 

Group ERP-1: Includes SAP, Web, Oracle, MSSQL, and Siebel (GUI-Oracle) 
Vuser protocols.

Group ERP-2: Includes SAP, Siebel (GUI-Oracle), Oracle, and Oracle-NCA 
Vuser protocols.

Group 3: Includes all Vuser protocols, except for SAP, Siebel (GUI-Oracle), 
Oracle, and Oracle-NCA.

The following types of monitors are available: System Resources, Web 
Resources, Web Server Resources, Web Application Server Resources, 
Database Server Resources, Network Delay, Streaming Media Resources, 
Firewall Server Resources, and ERP Server Resources. 

The Host ID box displays an ID for a specific machine. To receive a license 
key for a specific machine, contact Mercury Interactive’s Customer Support.

Modifying a License

You can only modify license information from the LoadRunner Controller, 
not from the Virtual User Generator.

To modify the current license information:

 1 In the Controller, choose Help > About LoadRunner. The About LoadRunner 
window opens.
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 2 Click the New License button. The New LoadRunner License dialog box 
opens. 

 3 Enter the new license number exactly as it was given to you. Click OK. If 
your license is limited for a specific amount of time, LoadRunner issues a 
message accordingly. 

 4 Click OK to close the New LoadRunner License dialog.

Troubleshooting 

If you have a temporary license key, contact Mercury Interactive Customer 
Support to obtain a permanent license key.

If LoadRunner does not accept your license key, perform the following 
checks:

Make sure you typed in the license key exactly as it was given to you. 
Your license key is case sensitive.

If your LoadRunner license requires that you use a plug when running 
LoadRunner, and a message is issued stating that a plug is not installed, 
perform the following:

Login as Administrator.

Run <loadrun_directory>/bin/hinstall.exe/i.

Reboot the machine.

If you receive a “permission denied” error message during Controller 
start-up, you must grant “Full Control” permission for the Registry's 
HKEY_LOCAL_MACHINE key and in the WINNT directory (directory 
where Windows is installed):
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To add Registry permissions: 

 1 Run regedt32 to modify the registry.

 2 Select the HKEY_LOCAL_MACHINE key.

 3 Select Security > Permissions.

 4 Add “Full Control” permission to the user that is running the Controller.

 5 Turn on the Replace Permission on the Existing Subkeys flag.

 6 Click OK.

To add permissions on an NTFS file system:

 1 Select the <System Drive>:\WinNT folder.

 2 Invoke Properties.

 3 Select the Security tab.

 4 Click Permissions.

 5 Add “Full Control” permission for the user.

 6 Turn on the Replace Permissions on Subdirectories flag.

 7 Click OK.
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5
Installing LoadRunner Samples

The LoadRunner installation includes sample Vuser scripts, a sample 
application, and sample database server and tables. In order to use the 
LoadRunner samples you must run complete the LoadRunner samples 
installation.

This chapter describes: 

Samples Setup Program

Samples Setup Procedure

Accessing the Readme File for Web, Corba or RMI

About LoadRunner Samples

The LoadRunner samples include:

Sample Vuser scripts

The scripts demonstrate some of LoadRunner’s features and allow you to run 
a true test.

Sample flight application

The sample application is a flight reservation system which enables travel 
agents to order flight tickets. Travel agents work on the client application 
which connects to a central database server. This application is available for 
the following protocols: Web, Com, Corba, RMI, ODBC, MS ACCESS, 
Oracle, Sybase, and WinSocket.
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Sample database server and tables

You can install the Quadbase server, which is an ODBC database server 
provided with LoadRunner for demonstration purposes, or you can 
configure the flight reservation system to connect to an existing database 
server. The installation program installs all of the necessary tables for 
working with the sample application on the server of your choice. 

Samples Setup Program

The LoadRunner samples setup program:

Installs the sample Quadbase ODBC Server and Client (optional).

Creates and populates data tables for use with the sample Flight application, 
on the Quadbase server or one of the other specified servers.

Installs the sample Vuser scripts and updates the database connection 
strings for the sample Vuser scripts.

Manages the flights.ini file to make it available for the Flight application.

Registers the datasource for Flight-ODBC_Access and Flight-Winsock with 
the ODBC Administrator.

Adds icons for the LoadRunner Samples program group.

Samples Setup Procedure

To install the LoadRunner samples on your computer:

 1 If you plan to use an existing database or WinSock application server, rather 
than installing the sample Quadbase ODBC server, make sure that your 
server is running and that you are familiar with the connection parameters.

 2 Run the samples setup from the LoadRunner Samples program group. 

The LoadRunner Samples Setup program begins and displays the Welcome 
dialog box.
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 3 Click Next to proceed to the list of components and sub-components. Select 
one or more componenets.

Click Next.
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 4 If you are installing samples for an Oracle or Sybase server, you will be 
prompted to provide connection information, according to the selected 
server type. The User Name, Password, and Host String fields will be filled in 
with the most recent information, if available on your system.

ODBC_access will display the default "flight32lr" and try to register it as a 
DSN with ODBC.

If you are installing the ODBC_Quadbase client, it will display the default 
"Quadbase". This is the same name used by the Quadbase server installation 
setup.

 5 Enter the connection information and click Next. For Oracle servers, select 
the version of the Oracle client and click Next.

 6 A message appears asking you if you would like to install or update the 
sample Flights database on your server. Click Yes.

 7 After all of the tables are created, you will receive a prompt that setup is 
complete. Click Finish to close the setup program and view the new program 
icons.
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Note: It is recommended to copy dat/flight32.mdb to your local drive and 
register it manually. If you leave this file on the network, other users may 
accidentally access it.

Accessing the Readme File for Web, Corba or RMI

The sample Readme files provide detailed information about using the WEB, 
CORBA, and RMI sample applications: 

For Web samples, look in:

Start > Programs > LoadRunner > Samples > WEB > Mercury Demo Web 
Application Readme

or

LoadRunner\samples\Web\MercuryReadme.doc

For RMI samples, look in:

Start > Start > Programs > LoadRunner > Samples > RMI > RMI Flights Help

For Corba samples, look in:

Start > Programs > LoadRunner > Samples > Corba > Corba Flights Help
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6
Introducing the UNIX Installation

You can install LoadRunner to run virtual users on a UNIX platform. The 
UNIX virtual users interact with the LoadRunner Controller, installed on a 
Windows machine. Refer to Part I of this Installation Guide for information 
about installing the LoadRunner Controller. This chapter discusses the 
installation steps and system requirements for the LoadRunner UNIX 
Virtual User components. 

UNIX Installation Steps

This guide describes the installation of LoadRunner Vusers on all of the 
supported UNIX platforms. When a section applies only to a specific 
platform, it is explicitly stated. 

The main steps of the installation process are:

Installing the program files

Setting the environment

Once you complete the installation, refer to the additional documentation 
for details on working with LoadRunner.
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Setting the Environment

Since LoadRunner virtual users emulate an actual user of your system, the 
environment on the virtual user machine must be configured for the user to 
run correctly. The environment variables are defined in the .cshrc file for 
cshell users, and the .profile file for Bourne and kshell users.

The installation process determines the platform upon which the Vuser is 
running, and prepares a script to modify the .cshrc file for cshell users. 
Bourne and kshell users should manually modify the .profile file. Refer to 
Chapter 9, “Verifying Your Installation” for sample .cshrc and .profile files.

The LoadRunner installation process helps you set the environment variable 
to indicate the location of the LoadRunner bin directory and any DLLs used 
by the underlying protocol. This environment variable is called LIBPATH on 
AIX, SHLIB_PATH on HP/UX, and LD_LIBRARY_PATH on Solaris and Linux.

System Requirements

Your actual memory requirements may vary, depending on your 
configuration. Note that installation procedure uses additional memory 
which becomes free after the installation. To ensure a smooth installation of 
the UNIX components, it is recommended that you make sure there is 
sufficient storage space, process entries, swap space, etc. in the disk partition 
where you intend to install LoadRunner. 

The following table describes the system requirements for each platform 
supported by Mercury Interactive for LoadRunner UNIX Vusers. 

Note that LoadRunner supports all X Servers. 

Platform Hardware Version

Solaris Ultra Sparc Solaris 2.6 or higher

HP HP 9000 series 700, 800, HP-UX 11.x or higher

IBM IBM RS/6000 AIX 4.3.3 or higher

Linux PC i486 Red Hat 6.0 or higher
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Note: Refer to http://www.mercuryinteractive.com/products/loadrunner/technical/ 
for the most updated installation requirements.

System Resources

The following describes the system resources required for each platform or 
operating system. The actual resources may vary depending on the number 
of Vuser licenses purchased. 

The resources for Vusers listed below apply to each virtual user. If you are 
installing multiple virtual users, you must multiply the figure by the 
number of virtual users. 

The Memory Space above describes a general C-Vuser type. Other types 
may take up more memory space. For example, each Web Vuser uses at least 
500 KB.

Disk Space
required for program installation

22 MB (34 for Linux)

Memory Space
each Vuser if run as thread

300 KB (at least). This amount may vary, 
depending on the operating system and 
platform, and does not include the 
memory used by the process.

Memory Space
each Vuser if run as process

1.5 MB (2.5 MB for Solaris)

Swap Space approximately 1:7 memory/swap ration

Free Process Entries
each Vuser if run as process

1

File Descriptors
each Vuser if run as thread

2 (see below)
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A Load Generator additionally uses the following File Descriptor resources:

14 file descriptors for the LoadRunner launch service

20 file descriptors for the LoadRunner agent

30 file descriptors for each Vuser driver. By default, there is a driver for every 
50 Vusers.

For example, to compute the number of file descriptors used in running 100 
threaded Vusers the Load Generator requires:

Total: 294 File Descriptors

If Vusers are run as processes instead of threads, one driver is run per Vuser. 
Therefore, each Vuser requires 30 file descriptors.

You can increase the number of file descriptors, process entries, and amount 
of swap space by configuring the kernel, as described in this chapter.

Note: Most operating systems using LoadRunner 7.0 or higher have 
sufficient default file descriptors, process entries, and swap space, and rarely 
require reconfiguration.

14 for LR launcher

20 for LR agent

60 for 2 drivers (30 x 2, each one drives 50 Vusers)

200 for 100 Vusers (each Vuser requires 2)
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Increasing Process Entries 

Each Vuser requires several free process entries. To increase the number of 
process entries on your system, you must reconfigure the kernel. 

Solaris 2.6

The following section describes how to reconfigure the kernel for Solaris 
operating systems.

 1 Locate the /etc/system file.

 2 Set the maximum number of processes in the system file. Type:

 3 Execute the touch/reconfigure command. Type:

 4 Reboot the machine. 

HP-UX

The following section describes how to reconfigure the kernel for HP 
platforms.

 1 Login as root.

 2 Invoke the sam tool to reconfigure the kernel. Type:

 3 Select Kernel Configuration>Configurable Parameters. 

 4 Set the following parameters to the desired values:

nproc: The number of simultaneous processes—(# of Vusers * 2) + 200
maxuser: The number of maximum users—DB + RTE Vusers + 20
maxuprc: The number of processes per user—# of Vusers * 2

 5 Reboot the machine.

set max_nprocs=number (e.g.712)

touch /reconfigure

sam &
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IBM

The following section describes how to reconfigure the kernel for IBM 
platforms using the AIX operating system.

 1 Display the current settings. Type:

 2 Increase the maximum number of process entries per user. Type:

 3 Set the nproc, maxusers parameters to the desired values.

Linux

The following section describes how to reconfigure the kernel for Linux 
platforms.

 1 Locate the /etc/security/limits.conf file.

 2 Set the maximum number of processes in the limits file. Type:

 3 Reboot the machine.

lsattr -EHl sys0

chdev -l sys0 -a maxuprocs = number (e.g.500)

hard nproc 8192
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Increasing File Descriptors

Each Vuser requires from 6 (non-GUI Vusers) to 27 (GUI Vusers) file 
descriptor entries. The procedure to increase the number of file descriptors 
differs between platforms and shells. 

All Platforms

In these examples, the number of descriptors is increased to the maximum 
of 1024.

 1 For sh and ksh users, type:

 2 For csh users type:

Solaris

The following section describes some alternate procedures to increase file 
descriptors on Solaris operating systems. In these examples, the number of 
descriptors is increased to the maximum of 1024. 

 1 Use the adb command to increase file descriptors (all shells). Note that 400 
HEX is the equivalent to decimal 1024. In the following example, kernel is 
the name of the kernel file, e.g., kernel/unix.

 2 You can also increase the maximum number of file processes by 
reconfiguring the kernel. 

Login as root and set the rlim_fd_max parameter inside the /etc/system file by 
typing:

set rlim_fd_max=1024

ulimit -n 1024

limit descriptors 1024

adb -w -k /kernel/dev/mem
rlimits+28?W 400
rlimits+28/W 400
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Save the file and reconfigure the system by typing:

touch /reconfigure. 

After reconfiguring the system, reboot the machine.

HP-UX

The following section describes how to increase file descriptors for HP 
platforms.

 1 Login as root.

 2 Invoke the sam tool to reconfigure the kernel. Type:

 3 Select Kernel Configuration > Configurable Parameters. 

 4 Set the maxfiles parameters to the desired values. This is the equivalent to 
file descriptors on Sun platforms. 

maxfiles: The number of files open at a given time, typically set to 60. 
Change it to 500 -1024. 

 5 Reboot the machine.

Linux

The following section describes some alternate procedures to increase file 
descriptors on Linux operating systems. In these examples, the number of 
descriptors is increased to the maximum of 8192. 

 1 Add the following line to the /etc/security/limits.conf file:

 2 Add the following line to the /etc/sysctl.comf file.

 3 Reboot the machine.

sam &

hard nfile 8192

fs.file-max = 8192
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Increasing Swap Space

Each Vuser requires swap space ranging from 200 KB to 4 MB. Before adding 
space to your system configuration, you should determine your paging 
requirements. For environments running programs with very large memory 
requirements, it is recommended to have paging space of four times the 
physical memory. If you do not have enough paging space, certain processes 
may be killed, and others will be unable to start.

Solaris

The following section describes how to increase swap space for machines 
running Solaris.

 1 List the available paging areas. Type:

 2 Display the available swap space. Type: 

 3 Create a new paging file. Type:

 4 Add the page file to the existing configuration. Type:

 5 Enable all swap areas listed in the filesystem configuration. Type:

swap -l

swap -s

mkfile size  path (e.g. mkfile 50m /extra/page_1)

/usr/etc/swapon -a /extra/page_1 0 102400

/usr/etc/swapon -a 
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IBM

The following section describes how to increase swap space for machines 
running the AIX Operating System.

 1 List the available paging areas. Type:

 2 Display the available swap space. Type: 

 3 Create a new paging file, using a value one quarter the size of the actual file 
size. For example, to create 200 MB of paging space in the chemvg volume 
group, type:

 4 To increase the size of an existing paging file, type:

(e.g chps -s 10 page_01 adds 40 MB to page_01).

 5 Add the page file to the existing configuration. Type:

 6 Enable all swap areas listed in the file system configuration file 
/etc/swapspaces. Type:

lsps -a

swap -s

mkps -a -n -s 50 chemvg

chps -s number paging_file

swapon paging_area (e.g. swapon /dev/paging_01)

swapon -a 
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7
Installing LoadRunner on UNIX

LoadRunner is installed using the installation media provided with the 
LoadRunner distribution package. The installation uses a Java Runtime 
Environment (JRE).

The following sections describe installing the LoadRunner UNIX 
components from a UNIX CD-ROM device. If a UNIX machine with a CD-
ROM device is not available, you can copy the UNIX components from the 
CD into a directory on your PC, and transfer them to a UNIX directory via 
ftp or an NFS mounting at a later stage.

Checking your Environment

Verify that a CD-ROM device is attached to your local or remote machine. 

Find out which device driver is available for use with this drive. The device 
driver is usually located in the /dev directory of the machine to which the 
drive is attached. Consult your system administrator for the name of your 
device. 
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Installing LoadRunner on Multiple Platforms

In order to run LoadRunner on multiple UNIX platforms, you need to install 
a separate version of LoadRunner, in a separate directory, for each platform. 
The installation directories must be accessible to all the platforms. At the 
end of installation, follow the instructions at the end of this chapter for 
modifying the environment variables to indicate the LoadRunner 
installation directories.

For example, in order to install LoadRunner on a site that has both Solaris 
and IBM machines, you could use the following directories:

For LoadRunner Solaris: /tools/mercury/sol/lrunner

For LoadRunner IBM: /tools/mercury/ibm/lrunner

If you intend to run multi-platform scenarios, both directories should be 
NFS mounted. The Solaris machine should access the IBM installation 
directory and vice versa.

Running the Installation Program

Before you begin the installation program, make sure you see the install 
script, install.sh from the CD. Note that most operating systems require you 
to mount the CD-ROM drive to a local directory. For information for 
mounting a CD-ROM on IBM, see “Preparing to Install from a CD-ROM 
(IBM only)” on page 57.

There are two installation modes, UI (or AWT) mode and console mode. 

To run the installation in UI mode, make sure that the DISPLAY 
environment variable is properly configured.

To run the installation in console mode, add the -console parameter to the 
command line. For example:

install.sh -console
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To run the LoadRunner installation program:

Note: The instructions below are for the UI mode.

 1 Type :

install.sh

The installation program begins and displays the license agreement.
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 2 Read the agreement and select the option to accept it. The LoadRunner 
installation program begins and displays the installation location dialog 
box.

Choose the location where you want to install LoadRunner. To select a 
different location, click Browse, choose a directory, and click OK.

Click Next.
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 3 A read-only dialog box with your installation settings appears. 

To select different installation settings, click Back. To begin installation, 
click Next. The installation process begins.
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 4 At the end of the installation, a message appears about setting the 
LoadRunner environment variables. The next step outlines this procedure. 
First complete the automatic installation by clicking Next. 

 5 The installation process prepared a file called env.sh that contains 
environment variable definitions for your cshell environment. Open the 
.cshrc file for each LoadRunner user and add the following statement:

source /opt/LoadRunner7/env.sh

where /opt/LoadRunner7 is the LoadRunner installation directory.

Bourne shell and kshell users should refer to Chapter 8, “Post Installation” 
for instruction on modifying the .profile file.

 6 Bring up a new terminal to run the .cshrc file. For more information about 
.cshrc files, see Chapter 8, “Post Installation.”

 7 Be sure to run verify_generator to verify your Vuser installation. This is a 
confirmation step, to ensure that the specified directory and device name 
are correct, and that you have sufficient disk space. For information about 
the tests performed by verify_generator, see Chapter 9, “Verifying Your 
Installation.”
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Preparing to Install from a CD-ROM (IBM only)

When installing LoadRunner on an IBM platform, you must mount the CD-
ROM drive to access the installation program.

To mount the CD-ROM drive:

 1 Insert the CD-ROM into the drive and log in or su as root.

 2 Create the LoadRunner installation directory by typing:

 3 To add a CD-ROM file system, you need to use SMIT. To enter the program, 
type:

 4 From within SMIT, select File Systems.

 5 Select Add/Change/Show/Delete File Systems.

 6 Select CD ROM File Systems.

 7 Select Add a CDROM File System.

 8 Choose a DEVICE name. Note that device names for CD-ROM file systems 
must be unique.

 9 Type in the following MOUNT POINT:

 10 Select the Do command, or click enter if you are using the ASCII interface.

 11 Quit the SMIT program.

 12 Type the following command in order to mount the CD-ROM file system:

 13 For the FILE SYSTEM Name, select either /dev/cd0 or /dev/cd1.

mkdir -p /usr/cdrom/lrun

smit storage

/usr/cdrom/lrun

smit mountfs
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 14 Select the mount directory:

 15 Select cdrfs to set the TYPE of file system.

 16 Select Yes to mount as a READ-ONLY system. 

 17 Select Do or Enter if you are using the ASCII interface.

 18 Close your connection as the root user.

Running the Uninstall Program

The uninstall program, like the installation program, uses a Java Runtime 
Environment (JRE). You can also run the uninstall program in UI mode, or 
in console mode. To run the program in console mode, add the console 
parameter to the end of the command line.

To run the LoadRunner uninstall program:

 1 To access the program, type:

cd <installation directory>/_uninst

 2 Type:

uninstall.bin [-console]

/usr/cdrom/lrun
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8
Post Installation

After installing LoadRunner, prior to starting work, you should check that 
your environment is configured properly. 

This chapter discusses:

Setting Environment Variables

Checking Authorizations

Sample .cshrc and .profile Files

After you complete the post-installation configurations, run the 
LoadRunner verification utility to check your installation. For more 
information, see Chapter 9, “Verifying Your Installation.”

Setting Environment Variables

The LoadRunner installation procedure created a file, env.sh which sets the 
environment variables. Rather than manually updating your .cshrc file with 
the variable definitions, you include a statement to access env.sh at the end 
of the .cshrc file. This section describes the environment variables in your 
env.sh file. Note that if you are working with kshell or Bourne shell, you 
should manually set these variables in your .profile file. The syntax in the 
examples below are for cshell users. For kshell and Bourne shell users, see 
“LoadRunner Settings in the .profile File” on page 62.

M_LROOT

PATH

LD_LIBRARY_PATH (Solaris, Linux), LIBPATH (AIX), SHLIB_PATH (HP-UX)
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M_LROOT: Set M_LROOT to the LoadRunner installation directory. For 
example:

PATH: The location of LoadRunner’s executable programs, the bin directory, 
must be added to the PATH variable. 

LD_LIBRARY_PATH: The path should include the location of LoadRunner’s 
dynamic libraries ($M_LROOT/bin). To set the path, type: 

Check the dynamic libraries used by your application, and make sure that 
their path is also included in the appropriate dynamic library path 
environment variable (LD_LIBRARY_PATH, SHLIB_PATH or LIBPATH).

To check the dynamic libraries used by your application, type:

Note: Remember that in order to use Oracle73, you need to add the path 
Oracle73 libraries to the dynamic libraries path environment variable.

setenv M_LROOT /tools/lrunner

set path = ($path $M_LROOT/bin)

setenv LD_LIBRARY_PATH ${LD_LIBRARY_PATH}:$M_LROOT/bin 
/*Solaris and Linux*/

setenv SHLIB_PATH ${SHLIB_PATH}:$M_LROOT/bin/*HP Platforms */
setenv LIBPATH “${LIBPATH}:$M_LROOT/bin” /*IBM Platforms */

ldd my_application  /* Sun and Linux platforms */
chatr my_application  /* HP platforms */
dump -H my_application  /* IBM platforms */
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Checking Authorizations

In order to execute Vusers on remote hosts, you must be authorized to 
execute a remote shell. To check your permissions on a host, type:

For Solaris, Linux and IBM platforms:

For HP platform: 

If you do not have permission, consult the .rhosts file (man rsh or remsh).

Sample .cshrc and .profile Files

LoadRunner Settings in the .cshrc File

The following is an example of LoadRunner settings within a user’s .cshrc 
file:

# LoadRunner settings #
#Chooses a path based on the location of the machine dependent LoadRunner 
installation

switch ("‘uname‘")
case SunOS:

setenv M_LROOT {replace with LoadRunner Solaris installation path}
setenv LD_LIBRARY_PATH ${LD_LIBRARY_PATH}:${M_LROOT}/bin

breaksw

    case HP-UX:
setenv M_LROOT {replace with LoadRunner HP-UX installation path}
setenv SHLIB_PATH ${M_LROOT}/bin ${SHLIB_PATH}

breaksw

case Linux:

rsh hostname ls

remsh hostname ls
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setenv M_LROOT {replace with LoadRunner SunOs installation path}
    setenv LD_LIBRARY_PATH ${LD_LIBRARY_PATH}:${M_LROOT}/bin
breaksw

case AIX:
       setenv M_LROOT {replace with LoadRunner AIX installation path}

setenv LIBPATH ${M_LROOT}/bin:${LIBPATH}
       breaksw
endsw

set path = ($M_LROOT/bin $path)

# End LoadRunner setting #

LoadRunner Settings in the .profile File

The following is an example of LoadRunner settings within a user’s .profile 
file for kshell and Bourne shell environments:

# LoadRunner settings #
#Chooses a path based on the location of the machine dependent LoadRunner 
installation

case "‘uname‘" in
SunOS)
 M_LROOT={replace w/ LR Solaris installation path} ; export M_LROOT
   LD_LIBRARY_PATH=${M_LROOT}/bin ; export LD_LIBRARY_PATH
;;

HP-UX)
    M_LROOT={replace w/ LR HP-UX installation path} ; export M_LROOT
    SHLIB_PATH={${M_LROOT}/bin ; export SHLIB_PATH
;;

AIX)
    M_LROOT={replace w/ LR AIX installation path} ; export M_LROOT
    LIBPATH=${M_LROOT}/bin ; export LIBPATH
;;
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Linux)
    M_LROOT={replace w/ LR Linux installation path} ; export M_LROOT
    LD_LIBRARY_PATH=${M_LROOT}/bin; export LD_LIBRARY_PATH

esac

PATH=${M_LROOT}/bin:${PATH}; export PATH

# End LoadRunner setting #
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9
Verifying Your Installation

LoadRunner has a setup verification utility verify_generator, that checks the 
LoadRunner setup. It checks environment variables and your .cshrc file to 
verify that they are set up correctly. The verify_generator utility checks the 
remote Vuser hosts. 

It is strongly recommended that you run verify_generator after a Vuser 
installation, before attempting to invoke LoadRunner. 

The verify_generator Test

The utility checks the following items in the Vuser environment: 

at least 128 file descriptors

proper .rhost permissions: -rw-r--r--

the host can be contacted using rsh to the host. If not, checks for the host 
name in .rhosts 

M_LROOT is defined

.cshrc defines the correct M_LROOT

.cshrc exists in the home directory

the current user is the owner of the .cshrc 

a LoadRunner installation does exist in $M_LROOT

the executables have executable permissions

PATH contains $M_LROOT/bin, and /usr/bin

the rstatd daemon exists and is running



LoadRunner Installation Guide • UNIX Installation

66

verify_generator Option

The verify utility checks the local host for its communication parameters 
and its compatibility with all types of Vusers. If you intend to run all of the 
Vusers on one host, type: 

verify_generator either returns ‘OK’ when the setting is correct, or ‘Failed’ and 
a suggestion on how to correct the setup.

The syntax of verify_generator is as follows:

verify_generator [-v]

-v
Provides detailed information about the checks.

verify_generator
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